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All Rights Reserved. Copyright © 2014, Yokogawa Electric Corporation

Foreword
This manual describes the procedure for using the DXA170 DAQStudio (hereinafter DAQStudio) 
to create custom display screens for the GX10, GX20, GP10, and GP20 paperless recorders 
(hereinafter the GX/GP). In this manual, the GX10 and DAQStudio are used in examples, but the 
procedure for the other models is the same. For further details, please refer to the user's manuals 
of the other products. 

■	 Applicable products
DXA170 DAQStudio (release number R5.02.01)
GX10/GX20 Paperless Recorder (with /CG option, release number R4)
GP10/GP20 Paperless Recorder (with /CG option, release number R4)

■	 Precautions
•	 The contents of this manual may change without notice due to performance and functional 

improvements. 

•	 Every effort has been made in the preparation of this manual to ensure the accuracy of its 
contents. However, should you have any questions or find any errors, please contact your 
nearest YOKOGAWA representative as listed on the back cover of this manual.

•	 Copying or reproduction by any means of all or any part of the contents of this manual 
without permission is strictly prohibited.

■	 Trademarks
•	 The Yokogawa company and brand names used in this manual are trademarks or 

registered trademarks of Yokogawa Electric Corporation. 

•	 Microsoft and Windows are trademarks or registered trademarks of Microsoft Corporation in 
the United States and/or other countries.

•	 Adobe and Adobe Acrobat are trademarks of Adobe Systems Incorporated in the United 
States and/or other countries.

•	 The company trademarks and registered trademarks used in this manual are not 
accompanied by the trademark or registered trademark symbols (™ and ®).

•	 The product names used in this manual are trademarks or registered trademarks of their 
respective holders. 
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PC system requirements for DAQStudio

●	 Operating system (OS)
Run DAQStudio under any of the following OSs.

•	 Windows 7 Home Premium (32-bit, 64-bit)
•	 Windows 7 Professional (32-bit, 64-bit) 
•	 Windows 8.1 (32-bit, 64-bit) 
•	 Windows 8.1 Professional (32-bit, 64-bit) 
•	 Windows 10 Home (32-bit, 64-bit) 
•	 Windows 10 Pro (32-bit, 64-bit) 

	 The languages displayed by the software under different language versions of the OS are 
as follows. 
OS language Software display language

(language that can be installed)
Japanese Japanese
English English
Chinese Chinese
German German
French French
Russian Russian
Korean Korean

●	 Personal computer
Configuration 

	 A PC that runs one of the OSs above, and that meets the following CPU and memory 
requirements.

CPU and main memory 
	 Intel x64 or x86 Pentium 4, 3 GHz or faster.
	 2 GB or more of memory.

●	 Hard disk
	 100 MB or more of free space. 

●	 CD-ROM drive
	 A CD-ROM disk drive supported by the OS (for use during installation). 

●	 Mouse
	 A mouse supported by the OS.

●	 Display
	 A video card recommended for use with the OS, and a display of 1024 × 768 dpi or higher 

with 65,536 colors or more (16-bit High Color) supported by the OS. 

●	 Communication port
	 An Ethernet port supported by the OS (10Base-T). Requires that TCP/IP protocol be 

installed.
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1.	 Overview
With the Custom Display function you can create your own monitor screens for use on 
GX/GP paperless recorders. Along with trend, digital, bar graph, and other displays, you 
can place images on your screens. Adding images of the site to your screens provides 
more intuitive monitoring of the actual process. 

You create custom display screens by using dedicated software, DXA170 DAQStudio. You can 
transfer the screens you create with DAQStudio onto the GX/GP using Ethernet communications 
or an external memory medium (SD card), and display them.

The screen below is an example of monitoring and recording temperature and level inside a tank 
with a custom display screen. This screen (hereinafter the example screen) is used throughout 
this manual in describing the process of creating custom display screens. 
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■	 Flow of creating custom displays

Preparation

• Create a schematic of the custom display
• Create image files (if applicable)

Steps on DAQStudio

Open a new screen

Create components

Set component attributes

Save the screen

Send the screen to the GX/GP

Close DAQStudio

Steps on the GX/GP

Display the custom display on the GX/GP

2
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2.	 Preparation

■	 Creating a schematic of the monitor screen
Before creating a custom display on DAQStudio, prepare a schematic to determine the 
placement of digital values, trends, images, and other objects. In DAQStudio, the digital values, 
trends, and other objects you place on the screen are called components. 

Tank temperature

Tank 1 temperature

Tank 2 temperature

Tank 3 temperature

Tank level

Tank 1 level 

Tank 2 level 

Tank 3 level 

Temp.

Tank 1

Temp.

Tank 2

Temp.

Tank 3

10°C 30°C−20°C 0°C

■	 Creating PNG files (if adding images)
If you plan on using images in your custom displays, create images with the following attributes. 
File format: PNG
File name: Up to 32 alphanumeric characters
In the example screen, the size of the PNG file of the tanks is 506 × 275 pixels. 

The GX/GP can display PNG files of the following sizes, in pixels. 
	 GX10/GP10: 640 or less (W) × 480 (450*) or less (H)
	 GX20/GP20: 800 or less (W) × 600 (570*) or less (H)

* If the screen's status display is left in its initial state (ON)

•	 If the image exceeds either the maximum width or height, the GX/GP cannot display it. 
•	 The GX/GP cannot resize the image to fit. Size the image appropriately before use. 
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3	 Steps on DAQStudio

3.1	 Opening a new screen
1.	On the Windows Start menu, click All programs > DAQStudio > DAQStudio to start 

DAQStudio. 

2.	On the menu bar, click File > New, or click the New ( ) button. 
The New dialog box appears.

3.	Under Model, select GX10/GP10, and then click OK. 
A new screen for the GX10/GP10 appears. Keep the initial main unit release number setting. 

		

New button

Components bar

Menu bar

Tool bar

Screen list

Channel list

Attributes area

Coordinates (X: 640, Y: 480)

Screen builder
area

Arrangement bar Screen size
GX10/GP10: 640×480 Pixels
GX20/GP20: 800×600 PixelsPointer coordinates

Edit button
Send button

Coordinates (X: 0, Y: 30) Status area

IMPORTANT 
When you open a new screen, any previously open screen (including the screen list) is 
discarded. To save a screen in progress, see section 3.4, "Saving screens." 
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3.2	 Creating components
You create trends, digital values, and other components in the screen builder area. You can 
create them in any order. The most recently placed components appear in front of previous 
components, but you can change the arrangement (to front, to back, forward, backward) at any 
time. Trend display components and static image components (images) cannot be displayed if 
they overlap (for details, see the user's manual). 
	 If trend display components (trends) overlap with other components, only the trend is displayed (and not 

the other components) whether it is arranged in front or in back of the other components. If two trends 
overlap, only the trend in front is displayed. If two static image components overlap, the one in back is 
not displayed, therefore you should place them so that they do not overlap. 

The buttons for components used in the example screen are shown in the table below. 

	

Tank temperature

Tank 1 temperature

Tank 2 temperature

Tank 3 temperature

Tank level

Tank 1 level 

Tank 2 level 

Tank 3 level 

Temp. ℃ Temp. Temp.

10℃ 30℃-20℃ 0℃

℃ ℃

Tank 1 Tank 2 Tank 3

Digital

Label
Trend

Simple digital

Label

ImageUnit

Simple bar 
graph

Button Name Component type Description

Trend Trend display Displays trend graphs. 

Digital Ch assignment
(general purpose)

Displays measured data from the assigned channel as 
numeric values. It can display channel numbers, alarm 
indicators, and other parameters. 

Label Label (general purpose) Displays user text strings.

Image Static image display 
(gen. purpose) Displays static images in PNG format.

Simple bar graph Ch assignment
(general purpose)

Displays measured data from the assigned channel in a 
bar graph.

Simple digital Ch assignment
(general purpose)

Displays measured data from the assigned channel as 
numeric values.

Unit Ch assignment
(general purpose)

This component displays the unit of the assigned 
channel.

For a complete list of component buttons, see appendix 2.
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■	 Main procedures and descriptions for creating components 
The maximum number of components that you can create on one screen is 210. This includes 
up to 200 general purpose components, up to 6 trend display components, and up to 4 summary 
display components (alarm or message summaries). For details, see the user's manual. 

	 Selecting a grid
	 You can select a grid in the screen builder area of 1, 5, 10, 20, or 50 dots. The initial value 

is 1 dot. The grid is displayed when you select something other than 1 dot. You can place 
components on the grid that you select. 

	 Creating components

1.	On the component bar, click the button of the component that you want to create. 

		

2.	Drag an outline in the screen builder area. 
The component is created in the size and location of the outline. You can change its size any time. 

		

Handles
(8)

DAQStudio assigns an ID number to components in the order that you create them, but it is not necessary 
to keep track of these numbers. 

	 Selecting components

	 To select a component, click it with the selection tool on the component bar ( ).  
	 You can select multiple components by holding down the Shift or Ctrl key while selecting 

them, or by dragging over them with the mouse. 

	 Reference component
	 A reference component is used when selecting multiple components and changing their 

alignments relative to each other. The handles of the reference component are gray. 
	 To change the reference component, select multiple components and then hold down the 

Ctrl key while clicking the new reference component. 

	 Changing the size of a component
	 To change a component's size, select the component and then drag one of its handles, or 

change the Width or Height value in the Attributes area. 

		

Drag to change the size Change the size in the properties

6
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	 Copying and pasting components
You can create a new component by copying an existing one. 

1.	Select a component to copy. 

2.	On the Edit menu, click Copy, or click the Copy ( ) button. 

3.	On the Edit menu, click Paste, or click the Paste ( ) button.

		

	 Moving components

	 You can move a component by dragging it, or by selecting it and clicking the arrow keys on 
the keyboard. 

	 You can also move it by changing its X and Y values in the Attributes area. 

	 The coordinates (X, Y) of a component refer to its anchor point, which is its upper-left vertex. 

		

	 Placing images

1.	On the component bar, click the Image ( ) button.

2.	Drag an outline in the screen builder area. 

		

Screen file
display area

3.	In the Attributes (Image) area, click the browse button. 

		  Browse

The Open dialog box appears.
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4.	Select an image file (PNG), and then click Open.
The selected image is displayed. If the image is larger than the image file display area, part of the image is 
hidden. 

			 

5.	In the Attributes area, you can change the width and height of the image file so that the 
entire image can be displayed. 
You can also drag a handle to resize the image. 

			 
	 By placing components in front of the tank image, you can make the tank look like the one in 

the example screen. 

			 

Label

Simple bar graph

Unit

Simple digital

Note 1:	 When placing multiple image components, ensure that they do not overlap. If they overlap, the image in 
back cannot be displayed. 

Note 2:	 DAQStudio displays the unit as "V." The GX/GP displays the unit of the channel assigned to the unit 
component. 

8
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	 Using the arrangement bar
	 By using buttons on the arrangement bar, you can easily change the alignment and size of 

components. Select multiple components, and then click one or more of the buttons. 

		

Reference component

Make heights same as
the reference component

Make widths same as
the reference component

Align left edges of 
components to the left 
edge of the reference 
component

Align upper edges, centers, or 
lower edges of components to 
that of the reference component

Move the selected component 
to front, to back, forward, or 
backward

Unify vertical space 
between components

Unify horizontal space 
between components

Click both buttons (in any order) to 
make the components the same size 
as the reference component. 

Center components

Right-align components
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3.3	 Setting component attributes
You can set the attributes of components that you place on the screen. The following describes 
only attributes that were changed in the creation of the example screen. Unless otherwise noted, 
the component's initial attributes are used. For details about component attributes, see the user's 
manual.

Digital 
(tank 1 temp.)

Digital
(tank 2 temp.)

Digital
(tank 3 temp.)

Digital
(tank 1 level)

Digital
(tank 2 level)

Digital
(tank 3 level)

LabelTrend

	 Trend
Digital display: Off

	 When you create a new trend component, it displays digital values unless the component 
is too small. The example screen only displays waveforms, therefore the digital display is 
turned Off. 

•	 The waveform direction is Setting (the initial value). Setting means it depends on the current 
setting of the GX/GP main unit. If it does not depend on the GX/GP main unit, you can set it 
to Vertical or Horizontal. 

	 Digital
Channels: Assign measurement channels. The example screen is set up as follows.

Tank 1 Tank 2 Tank 3
Temp. 0001 0002 0003
Level 0004 0005 0006

	 To assign a channel to a component, drag a channel from the channel list onto the 
component, or enter it in the Attributes area. For instructions on assigning channels from the 
channel list, see appendix 4 in this manual. 

Frame: Raised

10

TI 04L51B01-03EN



Simple digital

Label Image

Unit

Simple bar graph

	 Label
Text: Tank 1, Tank 2, Tank 3
You can use up to 64 characters (including double-byte characters). 
Background color: Selected color
Background color definition: White (R: 255, G: 255, B: 255)

	 Simple bar graph
Channels: Assign measurement channels to display as follows. 

Tank 1 Tank 2 Tank 3
0004 0005 0006

	 Unit
Channels: Assign measurement channels to display as follows. 

Tank 1 Tank 2 Tank 3
0001 0002 0003

	 Simple digital
Channels: Assign measurement channels to display as follows. 

Tank 1 Tank 2 Tank 3
0001 0002 0003

Text color: Channel color

	 Screen attributes
Screen name: Tank temperature monitor (use up to 16 alphanumeric, single-byte characters)
The screen name appears in the status display area of the GX/GP operation screen. In 
DAQStudio, it appears on the screen list. The initial value is "CustomDisplay01." You can name 
the screen before or after creating components. Click in any blank part of the screen builder area 
to display the screen attributes. 

11
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3.4	 Saving screens
1.	On the menu bar, click File > Save As.

The Save As dialog box appears. 

2.	Select a folder, or click New folder to create a folder. 
If you click the New folder button, type a name for the new folder. 

3.	Click OK. 
The screen is saved. All images will be saved to this folder unless you open a file from a different folder or 
save a file to a different folder. 

IMPORTANT 
•	 You cannot save screens to a network or compressed folder. 
•	 Save your image (PNG) files to the same folder as the screen. 

	 To overwrite an existing screen, click File > Save on the menu bar, or click the Save ( ) 
button.

When you select a file save folder, all screen information in the screen list area is saved (see 
figure below). The file names given when saved are as follows. 

Screen name in the screen list area in the initial state Name of saved file
CustomDisplay01 Custom01.GCD
-2- (When you add a screen, CustomDisplay02) Custom02.GCD
-3- (When you add a screen, CustomDisplay03) Custom03.GCD
↓ ↓
-28- (When you add a screen, CustomDisplay28) Custom28.GCD
-29- (When you add a screen, CustomDisplay29) Custom29.GCD
-30- (When you add a screen, CustomDisplay30) Custom30.GCD
You can change the name of a screen in the screen attributes. 

IMPORTANT 
The name of the saved file is fixed. Do not change the file name. If you change the name of 
a file, the GX/GP cannot load the screen. 

	 Screen list area and files saved
Screen list Screen list

Save the screens to the destination folder Save the screen to the destination 
folder (same folder as on left)

All current screens are discarded, and 
only the new screen 
(CustomDisplay01) is shown

3 files are saved:

Custom01.GCD
Custom02.GCD
Custom03.GCD

Custom01.GCD
is overwritten, and 
Custom02.GCD and
Custom03.GCD
are deleted. 

When opening a new screen
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3.5	 Sending screens to the GX/GP
These are the steps for sending screens via Ethernet communications. 

1.	Open the custom display screen you want to send to the GX/GP. 

2.	On the menu bar, click Communication > Send, or click the Send ( ) button. 
The Send dialog box appears. 

		

3.	Type the IP address or host name, user name, user ID, and password of the GX/GP.
If a user name is not set on the GX/GP you are sending to, type admin.

4.	Click the Send button.
A message appears.

5.	Click OK.
The currently displayed screen and any image (PNG) files used are sent to the GX/GP. 

You can also transfer screens to the GX/GP by using an external memory medium (SD card). For 
instructions, see appendix 5. 

IMPORTANT 
Save your image (PNG) files to the same folder as the screens (GDC). 

3.6	 Exiting DAQStudio
1.	On the File menu, click Exit, or click the Close button in the upper right ( ) of the main 

screen. 
If no screen is currently open, DAQStudio closes. If a screen is open, a message appears asking whether to 
save the screen. 

2.	Click Yes or No.
DAQStudio closes. 
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4.	 Steps on the GX/GP

Displaying custom displays
1.	Press the MENU key.

The Menu screen appears.

2.	Tap the Change screen tab. 

3.	Tap Custom display. 
The custom display screens sent from DAQStudio are displayed. 

		
Next, the following custom display selection menu appears. Tap the number of the screen you want to 
display. That screen appears. 
•	 Numbers of screens that were not sent are unavailable. 
•	 If a custom display does not have a name, only its number is displayed. 
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Appendix 1	 Conditional component display
You can configure components to display differently depending on triggers (alarm, switch, 
CompValue) in the component attributes of custom display screens. 

	 To display "Tank 1 temperature high alarm" when an alarm occurs

	

1.	Use the Label button on the component bar to create the label, "Tank 1 temperature high 
alarm" (in front of other components). 
Make sure the label does not overlap with the trend display component. If it overlaps with components of 
other types, the other components cannot be displayed. 

2.	Select the "Tank 1 temperature high alarm" label, and set its attributes. 
Attribute Setting Description
Visible: OFF Not visible when operation is normal
String: Tank 1 temperature abnormal Text to display (up to 64 characters allowed)
Text color definition: R: 255, G: 0, B: 0 Defines the color of the displayed text
Background color: Selected color Specified by the background color definition
Background color definition: R: 255, G: 255, B: 255 Specifies the color of the background in RGB 

values
Text alignment: Center The text is centered within the label component

(select Left, Center, or Right)
Frame: None None (initial value)

(select None, ColorFrame, Raised, or Sunken)
Frame color: — — — Specified as RGB values if ColorFrame is selected
Action settings
Action attribute: Visible Display on alarm occurrence
Value (when trigger target ON): On Displayed when an alarm is ON
Trigger: Alarm Target of trigger

(Select Alarm, Switch, or CompValue)
Action target number: 0001 Alarm target channel
Alarm level: All All alarm levels are targeted

(select 1, 2, 3, or 4)
CompValue — — — Available when the trigger setting is CompValue
Conditional expression — — — Available when the trigger setting is CompValue

The above settings cause the "Tank 1 temperature high alarm" label to appear if any of the alarm levels 1 
through 4 set for channel 0001 on the GX/GP turn ON. 
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Appendix 2	 Component buttons (GX/GP)
Component type Name Button Description

Edit Selects components in the screen builder area. 

Move
(the editing area)

When scroll bars appear in the screen builder area, use to drag the 
display area. 

Drawing
(general purpose)

Line Creates a straight line between two arbitrary points.

Rectangle Creates a rectangle of opposite angles defined by dragging the pointer. 

Circle Creates an ellipse defined by a rectangle of opposite angles defined by 
dragging the pointer.

Channel assignment 
(general purpose)

Simple digital Creates a component that displays the digital value of a specified channel. 

Multi display simple digital Create a simple digital component displaying the digital value of the 
specified channel that allows the text color and background to be changed 
according to the instantaneous value or alarm value status.

Digital Creates a component like the simple digital, but adds a tag (text/no.), 
channel number, unit, and alarm indicator.

Simple bar Creates a component that displays a bar graph of a specified channel.

Bar Creates a component like the simple bar graph, but adds a tag (text/no.), 
channel number, unit, and digital value.

Tag No. Creates a component that displays the tag number of a specified channel. 

Tag string Creates a component that displays the tag comment of a specified 
channel.

Unit Creates a component that displays the unit of a specified channel.

Alarm indicator Creates a component that displays the specified channel and alarm status 
of a specified level. 

Span Creates a component that displays the upper and lower limit of span of a 
specified channel.

Status display
(general purpose)

System symbols Create a component that displays a system symbol. The types of system 
symbol are: Memory sample , Alarm , SD card , Math , 
Key lock , Email , Instrument information , UserLock , and 
Program . 

Group name Creates a component displaying a group name.

Batch name Creates a component displaying the batch name.

User name Creates a component displaying the user name.

Date/time Creates a component displaying the current date and time.

Memory sample bar Creates a component displaying the progress of memory sampling.

Batch group number Create a component displaying the MultiBatch batch group number.

Batch number Create a component displaying the batch name.

Lot number Create a component for displaying and editing a lot number.

Batch comment Create a component for displaying and editing a batch comment.

Continued on the next page
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Component type Name Button Description
Text field title Create a component for displaying the title of a batch text field.

Status display
(general purpose)

Text field string Create a component for displaying and editing the character string of a 
batch text field.

Label
(general purpose)

Label Creates a label that displays an arbitrary string. 

Multi display
label

Create a label component that displays different text, text color, and 
background color according to the specified channel status.

Components included 
with the Action 
function
(general purpose)

DO/internal switch Creates a component that displays the internal switch status, and that can 
turn internal switches ON and OFF. 

Button operation Creates a component that displays buttons. 

Digital operation Creates a component that displays the value of specified communication 
input data, and that writes values as communication input data. 

Static image
(general purpose)

Image Creates a component that displays static images in PNG format. 

Summary display Alarm summary Creates a component that displays alarm summaries. 

Message summary Creates a component that displays message summaries.

Trend display Trend Creates a component that displays trends from specified groups.

Controller 
Components

Controller Create a component for monitoring loop control.

External controller Create a component for monitoring and controlling the control operation 
status using a communication channel.

Control alarm indicator Create a component displaying the alarm status of the specified loop.

General purpose: 
Trend display: 
Summary display: 

Up to 200 can be created on 1 screen. They are assigned component ID numbers from 0–199 in the order that they are created. 
Up to 6 can be created on 1 screen. They are assigned component ID numbers from 200–205 in the order that they are created.
Up to 4 can be created on 1 screen. They are assigned component ID numbers from 206–209 in the order that they are created.
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Appendix 3	 List of menus and buttons
File menu
Item Button Shortcut key Explanation

New Ctrl + N Discards any currently open screens and creates a new 
screen.

Open Ctrl + O Loads a screen builder file. The folder containing the 
opened file becomes the new destination folder for 
saving files. 

Save Ctrl + S Overwrites the screen builder file in the save destination 
folder with the current screen. 

Save As — — Saves the screen builder file to a selected folder. The 
selected folder becomes the new destination folder for 
saving files.

Export — — In the specified folder, a sub folder is created for each 
screen construction file, and the file is saved (GX/GP’s 
external media format).

Import — — A screen construction file saved in GX/GP’s external 
media format is imported and displayed.

Load Project 
Information…

— — A GA10 project information file (.pjf) is loaded.

Exit — — The application is exited.

Edit menu 
Item Button Shortcut key Explanation

Undo Ctrl + Z Undoes the previous edit operation.

Redo Ctrl + Y Redoes the undone edit operation.

Cut Ctrl + X Moves the selection to the clipboard. 

Copy Ctrl + C Copies the selection to the clipboard.

Paste Ctrl + V Copies the contents of the clipboard to the specified 
location. 

Select all — Ctrl + A Selects all components in the screen builder area.
Delete — Delete Deletes the selection. 
Add display — Adds a new screen to the screen list. 

View menu
Item Button Shortcut key Explanation

Channel /Loop — — Displays channel numbers in the channel list. 
Tag no. — — Displays tag numbers in the channel list.
Tag comment — — Displays tag comments in the channel list.
Grid — — Displays the grid spacing. 

1, 5, 10, 20, or 50 dots
Display List — — Displays the screen list. 
Operate area — — Displays the operation area. 
Attributes area — — Displays the attributes area.
Part bar — — Displays the component bar. 
Arrange bar — — Displays the arrangement bar.
Language — — The display language is switched. The default setting

depends on the OS language.
English, Japanese, Chinese, French, German, Korean,
Russian

Screen menu
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Item Button Shortcut key Explanation
DX Advanced R3(3) — — Sets the screen to the DXAdvanced R3 version.
DX Advanced R4.01(0) — — Sets the screen to the DXAdvanced 4.01 version.
DX Advanced R4.11(1) — — Sets the screen to the DXAdvanced 4.11 version.
GX/GP R2(2) — — Sets the screen to the GX/GP R2 version.
GX/GP R3(4) — — Sets the screen to the GX/GP R3 version.
GX/GP R4(6) — — Sets the screen to the GX/GP R4 version.
GA10 R3.01(5) — — Sets the screen to the GA10 R3.01 version.
GA10 R3.02(7) — — Sets the screen to the GA10 R3.02 version.

Arrangement (A) menu
Item Button Shortcut key Explanation

Left (L) — Aligns the left edges of selected components with that of 
the reference component.

Horizontal (Z) — Aligns the horizontal centers of selected components 
with that of the reference component.

Right (R) — Aligns the right edges of selected components with that 
of the reference component.

Top (P) — Aligns the top edges of selected components with that 
of the reference component.

Vertical  (Z) — Aligns the vertical centers of selected components with 
that of the reference component.

Bottom (M) — Aligns the bottom edges of selected components with 
that of the reference component.

Space horizontally (N) — Spaces selected components equally, with horizontal 
centers aligned.

Space vertically (V) — Spaces selected components equally, with vertical 
centers aligned.

Height (H) — Unifies the heights of selected components with that of 
the reference component. 

Width (W) — Unifies the widths of selected components with that of 
the reference component.

To front (T) — Brings the selected component to the front. 

To back (B) — Sends the selected component to the back.

Forward (O) — Moves the selected component forward by 1.

Back (A) — Moves the selected component backward by 1.

Communication (C) menu 
Item Button Shortcut key Explanation

Receive (R) — Receives a screen builder file from the GX/GP.

Send (S) — Sends a screen builder file to the GX/GP.

Help (H) menu
Item Button Shortcut key Explanation

User's manual (U) — F1 Displays the user's manual.
About (A) — Displays the About dialog box.
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Appendix 4	 Other operations

■	 Adding and copying screens
To create multiple custom displays, you can add new screens or copy existing screens. You can 
add up to 30 custom displays. 

	 Adding screens

	

1. Click the screen 
name to add

Screen is added

2. Click the Add screen 
button

When you add a screen, the screen name in the screen list changes, and the screen appears in the 
GX10/GP10 or GX20/GP20 screen builder area. 

	 Copying screens

	

1. Click the screen name of 
the copy source

2. Click the Copy 
button

4. Click the Paste button

3. Click the screen name of 
the copy destination

When you copy a screen, it is added with the screen name "Copy" + "name of copied screen." 

■	 Assigning channels to components
You can assign channels to components by dragging a channel from the channel list onto the 
component (channel assignment component). 

	

1. Drag the channel you wish to assign from 
the Channel list to the screen builder area. 

2. Drop the channel onto the object 
to which it is to be assigned.

Channel 2 is 
assigned
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Appendix 5	 Loading screens from 
external memory media

This is the procedure for loading screens saved in external memory media (SD cards) on the GX/
GP. 

■	 Loading specified screens

1.	Press the MENU key.
The Menu screen appears.

2.	Tap items in the following order. 

	 Screen change tab > Save/Load > Load settings > Custom display > Load specified 
custom display screen
The screen below is displayed. 

		

3.	Tap Media type, and then select a medium (SD). 

4.	Tap Select file, and then select a file (Custom01.GCD through Custom30.GCD). 
The screen name specified in DAQStudio is displayed. If necessary, set the screen number. 

5.	Tap Screen number, and then select a number from 1 to 30. 
Screen number: This is the number assigned to the custom display screen (1–30). This is necessary if you 

plan on specifying a custom display screen via communication.
When you set the screen number, Data changes from No to Yes. 

6.	Tap Run. 
The custom display screen is loaded from external memory media into internal memory. 
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■	 Loading all screens

1.	Press the MENU key.
The Menu screen appears.

2.	Tap items in the following order. 

	 Screen change tab > Save/Load > Load settings > Custom display > Load all custom 
display screens
The screen below is displayed.

		

3.	Tap Media type, and then select a medium (SD). 

4.	Tap Select folder, and then select the folder to load. 

5.	Tap Run. 
The custom display screen is loaded from external memory media into internal memory.
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